Section Maps and Data Interpretation in montaj Drillhole

Section maps provide cross sectional views of drillhole traces, coordinates, reference grids, assay values and other geological data. In the Drillhole system, section maps represent an important tool that enables you to display drillhole traces to help establish subsurface drilling coverage and visualize the geology, geochemistry, structures and other related data beneath the surface.

The ability to plot a Voxel slice on a Section map is now available. Use the 3D|3D Gridding menu to create a Voxel (.Geosoft_Voxel) using the Kriging or the Inverse Distance Weighted Gridding methods.

For more information on creating a Voxel, see the “montaj Drillhole 3D Tools” How-To Guide, which can be found on the My Geosoft Support site (https://geosoft.my.geosoft.com/).

In this How-to Guide, we will guide you through the following procedures:

- Select drillholes for viewing
- Create drillhole section map
- Geological interpretation using CAD tools

If you are planning on Wireframing your interpretations at a later date, you can add your interpretations to a Geostring file instead of a new map group. Please refer to the Target How-To Guide titled, “Digitizing Geological Interpretations on Section Maps” for more information on working with Geostring files and Wireframing.

Geosoft provides sample data for you to use when working through these How-To Guides. These data files can be found in your "...\Geosoft\resourcefiles\data\target" folder.

Selecting Holes for Sections

A key requirement for the geologists and geochemists that are evaluating and presenting drillhole data is the ability to select various combinations of drillholes for optimal visualization and plotting. The Drillhole system provides a comprehensive set of options for performing this task. The basic methods of hole selections are listed below.

- Selecting (or Deselecting) All Holes: Enables quick development of master plan maps or resetting of drillholes prior to making new selections.
- Selecting Holes by Name or Name Mask: Enables batch selection of multiple holes with systematic drillhole identifiers. Requires standard drillhole naming scheme for identifying related holes. For information on Name Mask parameters, click the Help button on the Select holes by name dialog.
- Selecting Holes from List: Enables single or multiple selection from a list dialog.
- Selecting Holes via a Selection Tool: Enables custom selection of single or multiple holes via a plan map of all the holes in the database. Requires pre-existing knowledge of holes.
- Select holes by Collar table data: Enables selection based on a range of values found in channel in the collar table.

The Drillhole system also enables the selecting or masking of data by code or range:

- Masking Data by Code: Provides the ability to create or update a mask channel based on values matched from any other channel.
- Masking Data by Range: Enables the setting of a mask channel dependent on whether values in a specified channel are within a specified range.
Selecting Holes using the Hole Selection Tool

The Hole Selection Tool enables custom selection of single or multiple holes using a dialog that displays a plan view of the drillhole project. This tool enables you to view "all holes", "selected holes" and holes including "full traces" or "labels". You can select interactively by drawing a polygon or by clicking holes individually. This method is best used if you have pre-existing knowledge of your drillholes and is an excellent way to preview the locations of your drillhole and the extents of your drillhole traces.

Selecting Drillholes using the Hole Selection Tool

1. On the DH-Plot menu, click Select Holes and then select Selection Tool. The Hole Selection Tool will appear.

2. In the Display section of the dialog, select All holes or Selected holes and select if holes include Full Traces and Hole Labels.

3. The drillhole plan view area can be modified using the Zoom In button ( ), the Zoom Out button ( ) and the Zoom Data Extents button ( ).

4. In the Selection Tools section of the dialog you can select the Select All or Select None buttons, or depending on
the Selection Mode you can Select/Deselect single holes ( ), Select/Deselect using rectangle tool ( ) or
Select/Deselect using polygon tool ( ).

5. To deselect all the holes click the Select None button.

6. Set the Selection Mode to Select and using the Select/Deselect buttons described above (single holes, rectangle
tool, polygon tool), select the drillholes. Selected drillholes will be highlighted, while deselected holes will be faded,
as shown below.

---

Selecting Holes from List
There are a number of methods available in the Drillhole system to select drillholes. This method uses the Select Holes
from List dialog.

To Select Drillholes from List
1. On the DH-Plot menu, click Select Holes and then select Selection Tool.
The Hole Selection Tool will appear.
2. Using this tool, scroll down through the list of drill holes in the Selected and Not Selected lists and verify that the correct holes have been selected.

3. Using the arrow buttons select or deselect additional drillholes as needed. Click OK to exit the dialog.

Creating a Drillhole Section Map

In the Drillhole system, section maps represent an important tool that enables you to display drillhole traces to help establish subsurface drilling coverage and visualize the geology and related geochemistry beneath the surface.

Section Plots

Drillhole section plot options are provided in easy-to-use tab menus, enabling quick access to all the settings from a single dialog. The dialog include sensible defaults; enabling easy creation of drillhole sections.

In this exercise, we will construct a East-West section displaying the nineteen selected drillhole traces. The drillhole section map will include the following:

- Local topography profile plotted across section
- Geology data displayed along traces using rock code patterns
- Assay data displayed along traces in a bar chart format
- Plan map window containing collar locations and magnetic data grid
- Profile window containing Au assay data profile

To Create a Section Plot

1. On the DH-Plot menu, click Section.

The Page Layout tab of the Section Parameters dialog appears.
2. In the **Map Setup** section, using the **Template** dropdown list, select the page layout size and orientation.

3. To determine **Map scale** based on the data extents and the selected map template, click the **Auto** button.

4. For organizational purposes you may want to specify the **Map Name Tag**.

5. In the **Components** section, select the components you want to include in your map.

6. To specify the section map layout, click the **Map Layout** button. The **Section Map Layout** dialog appears.

7. This dialog enables you to specify the layout of your section map including, the components to include, the order the components are displayed (top to bottom), the relative sizes of the components and the legend layout. Make any required change and click **OK** to return to the **Page Layout** tab.

8. Select your **Legend** parameters and specify the **Titles** text.

9. To specify the section location parameters, select the **Section Location** tab.
10. Select the correct Section Azimuth direction and click Default or Define to set the Location and Orientation parameters.

⚠️ If you select multiple sections each section will be displayed in individual maps. To plot multiple sections on a single map, see the Stacked Sections option.

11. To plot a profile across the section, select the Profile tab and check the Plot grid data profiles checkbox to enable the profile parameters.
12. Click **Browse** and the *Select grid file* dialog appears.
13. Use this dialog to select the grid file to use to calculate the profile. In our example, we selected the "Au_RL1.grd", provided with the sample data. Click **Open** to return to the *Section Parameters* dialog.
14. Click in the **Line Style** box and the Profile Options dialog appears.
15. Use this tool to define the profile options. Make any changes you feel are necessary and click the OK button to accept the changes and return to the Section Parameters dialog.

To plot a second or third topography profile, check the appropriate boxes to enable their parameters.

16. To plot geology and assay data along the hole traces in the section, select the Data tab.

The Plot boxes enable/disable the Data selection dropdown lists. This is a convenient way to select or de-select individual data plots, without clearing or re-selecting the data from the Data lists.
17. Using the *Data* dropdown lists, select the data channels available in the current project to plot. In this example, we are going to select Geology and Assay data.

   The selections combine the name of the channel, along with the identifier for the project database in which the channel is found.

18. Using the Plot Type dropdown lists, select the plot types. In this example, we are selecting *Bar plot* for the Assay data, and *Rock patterns* for the Geology data.

   Plot Types displayed are based on the data type of the selected Data. We show an example of a Bar Plot and Rock Patterns below.

19. Click the **Define** button beside the ‘Bar plot’ Plot Type to define the bar plot parameters. The **Bar Plot Parameters** dialog is displayed.
20. Using this dialog, you can define the plotting parameters for the bar plot.
21. Select which side of the drillhole trace you want to plot the bar plot.
22. Select the Fill as a Zone File and click Define to display the Define Colour Zones dialog.
23. Use this dialog to specify the **# Zones**, the **Distribution** and the **Maximum Value** of the zones. When finished, click **OK** to close the dialog and return to the *Bar Plot Parameters* dialog.

24. You can make further changes or leave the rest of the parameters to the default values.

25. When finished, click **OK** to return to the *Section Parameters* dialog.

26. We must now define our Geology plot, which we selected as *Rock patterns*. Click the **Define** button and the *Pattern Bands - Rock Codes* dialog appears.

27. Use this dialog to define the plotting parameters for the rock codes.

28. Select which side of the drillhole trace you want to plot the rock codes.
29. Select your Rock Code File. In our example, we are selecting the sample "Lithology.csv" file.
30. To edit the rock code file, click the Edit button on the right.
   The Edit Rock Codes dialog appears.

31. Click on any of the Code buttons to display the Edit rock code parameters dialog.
32. Use this dialog to edit the rock code parameters. Click in the *Pattern* box to display the *Pattern Attributes* dialog, using this dialog to define the pattern attributes. Click the **OK** buttons to accept your changes, until you return to the *Section Parameters* dialog.

33. To specify the plan map window parameters, select the *Plan View* tab.
34. To enable the plotting of a Plan view window on the Section Map, select (check) the *Plot plan view* box and specify the *Trace Style*.

35. To enable the plotting of a grid in the plan view window, select the *Plot grid or image in plan view* box. *Browse* to locate and select the grid file to display. In our example, we are selecting the "mag.grd" file provided with the sample data.

36. To specify the profile window parameters, select the *Profiles* tab.

37. To enable the plotting of a profile window, select the *Plot grid data profiles* box. *Browse* to locate and select the grid file to use to calculate the profile across the section.

38. Selecting the *Line Style* box displays the *Profile Options* dialog.
39. Use this dialog to specify the profile parameters and click the **OK** button to return to the *Section Parameters* dialog.

40. Click **OK** on the *Section Parameters* dialog. The section map is displayed.
Editing a Group

To edit a group click the **View/Group Manager** button ( ), the View/Group Manager Tool is displayed.

1. Select (highlight) the group you want to edit. Once a group is highlighted in the View/Group Manager Tool, you can change the properties for that group (for example, moveable, transparency, freeze group). You can also change the rendering or layering order of the groups by using Geosoft’s Drag-n-Drop capabilities.
2. To edit the selected group, click the **Edit** button. The selected group will be in edit mode. Hatch marks will be displayed around the group.
3. When you are satisfied with your changes, right-click and from the pop-up menu select, **End Editing**.

⚠️ There are many additional section-plotting options that you can include. As you become more familiar with the system, we recommend that you experiment with the other options to create a custom map of your own.

Geological Interpretation using CAD Tools

This section introduces you to the basic Geological interpretation and CAD functions available in Drillhole. The procedures are designed to show you how you can use these tools for drawing a geological interpretation.
If you are planning on Wireframing your interpretations at a later date, you can add your interpretations to a Geostring file instead of a new map group. Please refer to the Target How-To Guide titled, "Digitizing Geological Interpretations on Section Maps" for more information on working with Geostring files and Wireframing.

Topics covered in this section:

- Zoom for better viewing detail
- Create a new Group
- Drawing lines, poly-lines and polygons
- Use colour and polygon colour tools
- Create and edit rock code files

Zoom In for Better Viewing Detail

The Zoom In option enables you to enlarge an area of interest for better viewing detail.

To Use the Zoom In Option

1. Click the Zoom In button (🔍) on the Map Layout Bar, or right click on the map and select **Zoom Box** from the popup list.

2. Your cursor will turn into a crosshair (📊). Define a box by clicking the top left and bottom right corners of the area of interest. Then click once to execute the zoom command.

3. The system zooms into the defined area.

Create a New Group

Before you draw new lines, polygons or other CAD drawing items to your map, you must create a new map group.

- The Views available to draw on will depend on whether you are drawing on a plan map (Base, Data), section map (Base, Section), or a section with a plan map window contained within (Base, Data, Section).

- The Data and Section views are georeferenced, the Base view is not. The Base view refers to the coordinates of the page, in centimeters.

In the following procedure we will create a new group in a Section map.

To Create a New Group

1. On the **DH-Plot** menu, select **New Group**. The Create a new empty group in a view dialog is displayed.

2. Using the View dropdown list, select **Section** and then, type a name in the New group name test box.

3. Click the **OK** button and the new group will be added to the map and placed in **Edit mode**. This is visible on the map, by the hash marks surrounding the new group.
The new group will also be added to the View/Group Manager Tool and the Map Group Editing Bar will be enabled.

Drawing Lines or Polylines

You can use the line ( ) and polyline ( ) tools to draw linear features, for example, when interpreting the geology between the drillhole traces.

In the following procedure we will draw polylines on a section map.

**To Draw Polylines on a Section Map:**

1. On the Map Edit toolbar, click the **Draw a polyline** ( ) button.
2. Draw polylines connecting similar rock types between the drillhole traces. Click the cursor on the place you want the line to start, and then move the mouse, clicking wherever you want to change direction. When you are finished, right-click and select **Done** from the popup menu.
   Your new polyline will be added to the map.

**Using the Polygon Attributes Tool**

Using the **Get Polygon Attributes** (eyedropper) and the **Apply Polygon Attributes** (bucket) on the Map Group Editing Bar, you can copy fill colours and patterns from one polygon and apply them to another polygon.

**Get Polygon Attributes**

| ![Eyedropper](image) | The cursor adds an eyedropper image. |

**Apply Polygon Attributes**

| ![Bucket](image) | The cursor adds a bucket image. |
To Copy Polygon Attributes from one Polygon to Another

1. Click the Get Polygon Attributes button on the Map Group Editing Bar. The cursor adds an eyedropper image.
2. To copy polygon attributes, select the Get Polygon Attributes icon, and then click within the polygon containing the attributes (colour/pattern) you want to copy.
   The cursor’s image will change to a bucket, notifying you that you can now apply the polygon attributes.
3. Click within the polygon in which you want to apply the attributes.
   The attributes from one polygon will now be copied to the other polygon.

Polygon Edit Tools

A Polygon Edit toolbar is provided with Oasis montaj. These tools enable you to edit polygon vertices, add exclusion regions to polygons, and switch between editing the vertices of main polygons (Islands) and vertices of the exclusion regions polygons (Holes).

<table>
<thead>
<tr>
<th>Attributes...</th>
<th>Edit Vertices...</th>
<th>Add Vertices...</th>
<th>Delete Vertices...</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Group Editing</td>
<td>Edit Vertices...</td>
<td>Num +</td>
<td>Num -</td>
</tr>
<tr>
<td>Render Order</td>
<td>Nudge</td>
<td>Delete</td>
<td></td>
</tr>
</tbody>
</table>

Edit Vertices

The Edit Vertices option is available on the Map Edit pop-up menu when you are in Group Edit mode and have a polygon selected on your current map.
<table>
<thead>
<tr>
<th>Polygon Edit Tools</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Vertices</td>
<td>Edits the vertices of a previously created polygon.</td>
</tr>
<tr>
<td>Add Vertices</td>
<td>Adds new vertices to a polygon.</td>
</tr>
<tr>
<td>Delete Vertices</td>
<td>Deletes vertices from a polygon.</td>
</tr>
<tr>
<td>Add New Rectangular Island</td>
<td>Add a new rectangular “Island” to a previously created polygon.</td>
</tr>
<tr>
<td>Add New Polygon Island</td>
<td>Adds a new polygon “Island” to a previously created polygon.</td>
</tr>
<tr>
<td>Add New N-Sided Polygon Island</td>
<td>Draws a new N-sided polygon “Island” to a previously created polygon.</td>
</tr>
<tr>
<td>Add New Rectangular Hole</td>
<td>Adds a new rectangular “Hole” to a previously created polygon “Island”.</td>
</tr>
<tr>
<td>Add New Polygon Hole</td>
<td>Adds a new polygon “Hole” to a previously created polygon “Island”.</td>
</tr>
<tr>
<td>Add New N-Sided Polygon Hole</td>
<td>Draws a new N-sided polygon “Hole” to a previously created polygon “Island”.</td>
</tr>
<tr>
<td>Cycle to Previous Hole/Island</td>
<td>Cycles (switch) to the previous Hole or Island.</td>
</tr>
<tr>
<td>Cycle to Next Hole/Island</td>
<td>Cycles (switch) to the next Hole or Island.</td>
</tr>
<tr>
<td>Delete Current Hole/Island</td>
<td>Deletes the current Hole or Island.</td>
</tr>
</tbody>
</table>

**Add/Remove Vertices on a Polygon**

Vertices can be added or removed from polygons by using the plus (+) and minus (-) keys on your **Number Keypad**.

⚠️ The plus (+) and minus (-) keys on the main alpha-numeric keypad will not work; you **MUST** use the **Number Keypad** only.
To Access the Edit Polygon Vertices Option

1. Click **Map Group Mode**, on the **Map Tools Bar**.

2. Select the group on your map that includes the polygon you wish to edit.

3. While holding your cursor over your map, right click and select **Edit This Group** from the pop-up menu. The group will now be in **Edit** mode (you will see a box with hatch marks around the group, this is a visual clue that you are in **Edit** mode).

4. Select the polygon to edit.

5. Right-click and select **Edit Vertices** from the pop-up menu. The vertices on your map will change from grey to white.

To Add Additional Vertices on a Polygon

1. While in **Edit** mode, select **Edit Vertices** from the pop-up menu.

2. Place your cursor, between two vertices on the polygon, where you want to place the new vertex(s).

3. Press and hold the “+” key on your **Number Keypad**. A plus sign is added to your cursor.

4. While holding down the “+” key, use your mouse to select the location for the new vertex(s).

   You can also select **Add Vertices** from the Polygon Edit Bar. Your cursor will change to a cross-hair and it will be linked to the polygon lines. Left-click to add new vertices to the polygon.

To Remove Vertices from a Polygon

1. While in **Edit** mode, select **Edit Vertices** from the pop-up menu.

2. Place your cursor on the vertex(s) you want removed.

3. Press and hold the “-” key on your **Number Keypad**. A vertices selection box and a minus sign are added to your cursor.

4. While holding down the “-” key, use your mouse to select the vertices to be removed.

   You can also select the **Delete Vertices** button from the Polygon Edit Bar. Your cursor will change to a vertices selection box with a minus sign added. Left-click to delete vertex(s) from the polygon.

Creating and Editing Rock Code Files

Rock codes and their associated patterns are usually used with From-To data to display pattern fills on maps. You can use the editing tool to edit the rock codes in an existing file or to create a new file.

To Create a New Rock Code File:

1. On the **DH-Data** menu, select **Edit Rock Codes**.

   The **Drill-Hole - Edit Rock Codes** dialog appears. Note that the default rock code file "agso.csv" will be displayed.
You can set the default rock code file at anytime using the Preferences option on the DH-Data menu.

2. For the Rock codes list file (*.csv) field, enter a name for your new rock code file. This will create a new rock code file in *.csv file format. You can also open and edit an existing rock code file from this dialog.

3. Click **Edit**. The *Edit Rock Codes* dialog appears.

4. Click **Populate from channel**.
   The Select data source dialog appears. This dialog enables you to select a current database channel from which the rock code file will be automatically populated.
5. From the Channel/Database dropdown list, select your desired channel and click **OK**.
6. A message window opens indicating that there are new items to import into the rock code file. Click **Yes**. The *Edit Rock Codes* dialog box is now populated with the codes from your chosen channel within your From-To database.

**To Edit Individual Rock Codes**

1. In the *Edit Rock Codes* dialog click inside the *Description* box beside a rock code to provide a short description of the rock type.

2. Click in the *Pattern* box beside a rock code to edit its colour and/or pattern. The *Pattern Attributes* dialog appears. You can use this dialog to select the Pattern Family, Pattern, Colour, Background Colour, Tile Size, Tile Density and Line Thickness.

3. Select a pattern type via the *Pattern Family* dropdown menu.
4. Click in the *Colour* box to change the colour of the pattern.
5. The size and density of the pattern shapes can be set via the *Tile Size* and *Tile Density* boxes.

6. The *Example* pane shows you how your rock code pattern will look as you change the above parameters.

7. Once you are satisfied with the pattern for the rock code click **OK** to save it and the system will return you to the *Edit Rock Codes* dialog.